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Ⅱ．個別検査方法  

  (略) 

 

亜麻（FP967）の検査方法 

（略） 

 

コムギ（MON71200、MON71100/71300、MON71700、MON71800、HB4） 

の検査方法 

（略） 

 

1. DNA 抽出精製 

（略） 

 

2. 定性リアルタイム PCR 法 

 遺伝子組換えコムギの検出は、各系統特異的検知試験用のプ

ライマー、プローブを用いたリアルタイムPCR、及びコムギ陽性

対照試験用のプライマー、プローブを用いたリアルタイムPCR

の2試験を行い判定する。MON71200、MON71700、MON71800、HB4

系統特異的検知試験用として、コムギゲノム配列と遺伝子発現

用ベクターの境界領域を検知するプライマー、プローブを用い

る。MON71100/71300系統特異的検知試験用として、コムギゲノ

ムに挿入されたトランスジェニック構造配列を検知するプラ

イマー、プローブを用いる。また、コムギ陽性対照試験用とし

Ⅱ．個別検査方法  

  (略) 

 

亜麻（FP967）の検査方法 

（略） 

 

コムギ（MON71200、MON71100/71300、MON71700、MON71800） 

の検査方法 

（略） 

 

1. DNA 抽出精製 

（略） 

 

2. 定性リアルタイム PCR 法 

遺伝子組換えコムギの検出は、各系統特異的検知試験用のプ

ライマー、プローブを用いたリアルタイム PCR、及びコムギ陽

性対照試験用のプライマー、プローブを用いたリアルタイム

PCR の 2 試験を行い判定する。MON71200、MON71700、MON71800

系統特異的検知試験用として、コムギゲノム配列と遺伝子発現

用ベクターの境界領域を検知するプライマー、プローブを用い

る。MON71100/71300 系統特異的検知試験用として、コムギゲノ

ムに挿入されたトランスジェニック構造配列を検知するプラ

イマー、プローブを用いる。また、コムギ陽性対照試験用とし



て、Acetyl-CoA carboxylase 1（ACC1）遺伝子配列を検知する

プライマー、プローブを用いる。各プライマー、プローブは純

水に溶解する。プライマー、プローブの塩基配列は以下のとお

りである。 

MON71200系統特異的検知試験用のプライマー対及びプローブ 

MON71200-3’ junction-1F: 5’-CAC GAC GGT CAT CGA GC-3’ 

MON71200-3’ junction-1R: 5’-CCG TTC GTC ATT GAC TGT T-

3’ 

MON71200-3’junction-P*: 5’-HEX-CAT ACG GAA/ZEN/AAG ATG 

CTG CAG GGA ATA TAT TGA AC-IABkFQ-3’ 

* MON71200-3’ junction-Pは、内部に ZENと3’末端に

IowaBlack™（IABkFQ）を修飾したダブルクエンチャープロー

ブである。 HPLC精製グレードのものを Integrated DNA 

Technologies（IDT）社で入手可能である。 

MON71100/71300系統特異的検知試験用のプライマー対及びプ

ローブ 

SQ0814: 5’-GCG CGG TGT CAT CTA TGT TAC TAG-3’ 

SQ0815: 5’-TGA CCT CGA GTA AGC TTG TTA ACG-3’  

PB0103 probe: 5’-FAM-ACC AAG CTT GAT ATC C-MGB-3’ 

MON71700 系統特異的検知試験用のプライマー対及びプロー 

ブ 

71700 forward primer: 5’-CCA TCA TAC TCA TTG CTG ATC CAT 

GT-3’ 

て、Acetyl-CoA carboxylase 1（ACC1）遺伝子配列を検知する

プライマー、プローブを用いる。各プライマー、プローブは純

水に溶解する。プライマー、プローブの塩基配列は以下のとお

りである。 

MON7120 系統特異的検知試験用のプライマー対及びプローブ 

MON71200-3’ junction-1F: 5’-CAC GAC GGT CAT CGA GC-3’ 

MON71200-3’ junction-1R: 5’-CCG TTC GTC ATT GAC TGT T-

3’ 

MON71200-3’ junction-P*: 5’-HEX-CAT ACG GAA/ZEN/AAG ATG 

CTG CAG GGA ATA TAT TGA AC-IABkFQ-3’ 

* MON71200-3’ junction-P は、内部に ZEN と 3’末端に

IowaBlack™ （IABkFQ）を修飾したダブルクエンチャープロー

ブである。HPLC 精製グレードのものを Integrated DNA 

Technologies（IDT）社で入手可能である。 

MON71100/71300 系統特異的検知試験用のプライマー対及びプ

ローブ 

SQ0814: 5’-GCG CGG TGT CAT CTA TGT TAC TAG-3’ 

SQ0815: 5’-TGA CCT CGA GTA AGC TTG TTA ACG-3’  

PB0103 probe: 5’-FAM-ACC AAG CTT GAT ATC C-MGB-3’ 

MON71700 系統特異的検知試験用のプライマー対及びプロー  

ブ 

71700 forward primer: 5’-CCA TCA TAC TCA TTG CTG ATC CAT 

GT-3’ 



71700 reverse primer: 5’-CGG CAT GCG CCA ATC AGT-3’ 

71700 FAM-probe: 5’-FAM-TTC CCG GAC AGC GGC GGC GG-

TAMRA-3’ 

MON71800系統特異的検知試験用のプライマー対及びプローブ 

SQ0718: 5’-TTC TTC TCT CTC TTT GAA TCT CAA TAC AA-3’ 

SQ0719: 5’-CCC CCA TTT GGA CGT GAA-3’ 

PB0101: 5’-FAM-TCC CCC TCT CTA ATT C-MGB-3’ 

HB4系統特異的検知試験用のプライマー対及びプローブ 

HB4wheat_MS F: 5’-CCT TTC GAC TCC CAT TGA GGG-3’ 

HB4wheat_MS R: 5’-TGT TGC CAT TGC TAC AGG CAT-3’ 

HB4wheat_MS P: 5’-FAM-CCC GGA TTA GGG GGT GTT TGG AAC 

ACC A-BHQ1-3’ 

コムギ陽性対照試験用のプライマー対及びプローブ*1 

acc forward primer: 5’-GCC TAC CCC CTT CAA CAA GAT GA- 

3’ 

acc reverse primer: 5’-GTA CGC GCT TGA ACC CTT TTT TTG- 

3’ 

acc FAM-probe:5’-FAM-CCA CCG ACG AGT TAA AAC CAA AGA TAC 

ACG-TAMRA-3’ 

*1 代替法として、以下のプライマー対及びプローブを使用す

ることも可能である。 

PRP8F: 5’-GCA CCC ATG ATG AGT ACT ACT ATT CTG TA-3’ 

PRPds6R: 5’-TGC AAA CGA ATA AAA GCA TGT G-3’ 

71700 reverse primer: 5’-CGG CAT GCG CCA ATC AGT-3’ 

71700 FAM-probe: 5’-FAM-TTC CCG GAC AGC GGC GGC GG-

TAMRA-3’ 

MON71800 系統特異的検知試験用のプライマー対及びプローブ 

SQ0718: 5’-TTC TTC TCT CTC TTT GAA TCT CAA TAC AA-3’ 

SQ0719: 5’-CCC CCA TTT GGA CGT GAA-3’ 

PB0101: 5’-FAM-TCC CCC TCT CTA ATT C-MGB-3’ 

（新設） 

 

 

 

 

コムギ陽性対照試験用のプライマー対及びプローブ*1 

acc forward primer: 5’-GCC TAC CCC CTT CAA CAA GAT GA-

3’ 

acc reverse primer: 5’-GTA CGC GCT TGA ACC CTT TTT TTG-

3’ 

acc FAM-probe:5’-FAM-CCA CCG ACG AGT TAA AAC CAA AGA TAC 

ACG-TAMRA-3’ 

*1 代替法として、以下のプライマー対及びプローブを使用す

ることも可能である。 

PRP8F: 5’-GCA CCC ATG ATG AGT ACT ACT ATT CTG TA-3’ 

PRPds6R: 5’-TGC AAA CGA ATA AAA GCA TGT G-3’ 



PRP-Taq5: 5’-FAM-CTG TGC ACA TGA CTC AGT TGT TCT TTC  

GTG-TAMRA-3’ 

 

2.1. リアルタイムPCR反応液の調製*1 

DNA試料液あたり各試験は、それぞれ2ウェル併行して行う 

ものとする。各ウェルのリアルタイムPCR反応液は25 µL/well

として調製する。 

コムギ陽性対照試験、MON71100/71300系統特異的検知試験、

MON71700系統特異的検知試験、MON71800系統特異的検知試験及

びHB4系統特異的検知試験の組成は以下のとおりである。

FastStart Universal Probe Master (Rox)（Roche Diagnostics

社）*2 12.5 µL、各対象プライマー溶液（各50 µmol/L）各0.25 

µL、対象プローブ溶液（10 µmol/L）0.5 µLを混合し、純水で全

量20 µLに調製後、DNA試料液5 µLを添加する*3。 

MON71200系統特異的検知試験の組成は以下のとおりである。

FastStart Universal Probe Master (Rox) *2 12.5 µL、

MON71200-3’ junction-1Fプライマー（50 µmol/L）0.2 µL、

MON71200-3’ junction-1Rプライマー（50 µmol/L）0.4 µL、 

対象プローブ溶液（10 µmol/L）0.5 µLを混合し、純水で全量 

20 µLに調製後、DNA試料液5 µLを添加する*3。 

リアルタイムPCRのブランク反応液*4として、必ずDNA試料 

液の代わりに純水を加えたものについても同時に調製する。 

分注操作終了後、96ウェルプレートに真上からシールし、完

PRP-Taq5: 5’-FAM-CTG TGC ACA TGA CTC AGT TGT TCT TTC 

GTG-TAMRA-3’ 

 

2.1. リアルタイム PCR 反応液の調製*1 

DNA 試料液あたり各試験は、それぞれ 2 ウェル併行して行う

ものとする。各ウェルのリアルタイム PCR 反応液は 25 µL/well

として調製する。 

コムギ陽性対照試験、MON71100/71300 系統特異的検知試験、

MON71700 系統特異的検知試験及び MON71800 系統特異的検知試

験の組成は以下のとおりである。FastStart Universal Probe 

Master (Rox)（Roche Diagnostics 社）*2 12.5 µL、各対象プラ

イマー溶液（各 50 µmol/L）各 0.25 µL、対象プローブ溶液（10 

µmol/L）0.5 µL を混合し、純水で全量 20 µL に調製後、DNA 試

料液 5 µL を添加する*3。 

MON71200 系統特異的検知試験の組成は以下のとおりである。

FastStart Universal Probe Master (Rox) *2 12.5 µL、

MON71200-3’ junction-1F プライマー（50 µmol/L）0.2 µL、

MON71200-3’ junction-1R プライマー（50 µmol/L）0.4 µL、

対象プローブ溶液（10 µmol/L）0.5 µL を混合し、純水で全量

20 µL に調製後、DNA 試料液 5 µL を添加する*3。 

リアルタイム PCR のブランク反応液*4として、必ず DNA 試料

液の代わりに純水を加えたものについても同時に調製する。 

分注操作終了後、96 ウェルプレートに真上からシールし、完



全にウェルを密閉する。このとき、しわが寄らないよう注意す

る（専用のシーリング用アプリケーターを用いて行うと良い）。

最後にウェルの底を観察し、底に気泡がある場合は、プレート

の縁を軽く叩いて気泡を抜いておく。 

*1 Thermo Fisher Scientific社製のリアルタイムPCR機器は、

96ウェルプレートとして MicroAmp Optical 96-Well 

Reaction Plate（Thermo Fisher Scientific社）、シールと

して MicroAmp Optical Adhesive Film（ Thermo Fisher 

Scientific社）を使用する。Roche Diagnostics社製のリア 

ル タ イ ム PCR 機 器 は 、 96 ウ ェ ル プ レ ー ト と し て 

LightCycler480 Multiwell Plate 96（Roche Diagnostics 

社）、シールとしてLightCycler 480 Sealing Foil（Roche 

Diagnostics社）を使用する。 

*2 FastStart Universal Probe Master (Rox)の代わりに、同 

等の性能を有するものを用いることができる。これらを含む

溶液は粘性が高いため、混合操作を行う際には、混合が確実

に行われるように注意する。不十分な場合には、PCRがうま 

くいかない場合がある。また、本試薬はボルテックス等によ

る激しい攪拌が禁止されているため、使う直前には必ず転倒

混和等で優しく混合し、遠心機でスピンダウンして、溶液を

試料管の底に集めておいてから使用する。また、ウェルに分

注する際は、以後撹拌、遠心が困難なことを考慮し、ウェル

の底に確実に入れる。 

全にウェルを密閉する。このとき、しわが寄らないよう注意す

る（専用のシーリング用アプリケーターを用いて行うと良い）。

最後にウェルの底を観察し、底に気泡がある場合は、プレート

の縁を軽く叩いて気泡を抜いておく。 

*1 Thermo Fisher Scientific 社製のリアルタイム PCR 機器は、

96 ウェルプレートとして MicroAmp Optical 96-Well 

Reaction Plate（Thermo Fisher Scientific 社）、シールと

して MicroAmp Optical Adhesive Film（Thermo Fisher 

Scientific 社）を使用する。Roche Diagnostics 社製のリア

ルタイム PCR 機器は、 96 ウェルプレートとして

LightCycler480 Multiwell Plate 96（Roche Diagnostics

社）、シールとして LightCycler 480 Sealing Foil（Roche 

Diagnostics 社）を使用する。 

*2 FastStart Universal Probe Master (Rox)の代わりに、同

等の性能を有するものを用いることができる。これらを含む

溶液は粘性が高いため、混合操作を行う際には、混合が確実

に行われるように注意する。不十分な場合には、PCR がうま

くいかない場合がある。また、本試薬はボルテックス等によ

る激しい攪拌が禁止されているため、使う直前には必ず転倒

混和等で優しく混合し、遠心機でスピンダウンして、溶液を

試料管の底に集めておいてから使用する。また、ウェルに分

注する際は、以後撹拌、遠心が困難なことを考慮し、ウェル

の底に確実に入れる。 



*3 冷凍庫から出した試薬類は、必要なものにつき室温で融解

後、氷上で保存する。氷上で保存した試薬につき、同一のチ

ップを用い連続分注すると、ピペット内の空気が冷却される

ため、2回目以降、通常のピペット操作では正確に分注され 

ないので注意する。ピペットの説明書に書かれた、低温試料

を扱う場合の操作法（通常、ふきとめと呼ばれる操作）を理

解して使用する。 

*4 Non-Template Control（NTC）は、DNA試料液の代わりに純 

水を1ウェルに5 µL添加したものとする。 

 

2.2. リアルタイムPCRによる測定 

（削る） 

 

 

 

 

 

 

 

 

 

 

 

*3 冷凍庫から出した試薬類は、必要なものにつき室温で融解

後、氷上で保存する。氷上で保存した試薬につき、同一のチ

ップを用い連続分注すると、ピペット内の空気が冷却される

ため、2 回目以降、通常のピペット操作では正確に分注され

ないので注意する。ピペットの説明書に書かれた、低温試料

を扱う場合の操作法（通常、ふきとめと呼ばれる操作）を理

解して使用する。 

*4 Non-Template Control（NTC）は、DNA 試料液の代わりに純

水を 1ウェルに 5 µL 添加したものとする。 

 

2.2. リアルタイム PCR による測定 

2.2.1. プレート情報の設定 

検体の配置とプローブの特性に注意しながら、リアルタイム

PCR 機器の製品付属のマニュアルを参考にして設定する。プロ

ーブ特性に関しては、MON71200 系統特異的検知試験では

Reporter を  HEX」又は VIC」、Quencher を  Non Fluorescent」、

コムギ陽性対照試験及び MON71700 系統特異的検知試験では

Reporter を FAM」、Quencher を TAMRA」、MON71100/71300 系

統特異的検知試験及び MON71800 系統特異的検知試験では

Reporter を FAM」、Quencher を Non Fluorescent」となるよ

うに設定する。また、Passive Reference の指定のあるリアル

タイム PCR 機器の場合は、 ROX」を設定する。Sample Volume は

25 µL に設定する。 



（削る） 

 

 

 

 

 

 

 

 

 

2.2.1. ABI 7500、LightCycler 480、QuantStudio 5、又は

QuantStudio 12K Flexを使用した操作方法 

以下参考として、ABI 7500、LightCycler 480、QuantStudio 

5 又は Quantstudio 12K Flex を使用した操作方法を記述する

が、上記 4機種と同等の性能を有するものも使用可とする。 

 

（削る） 

 

 

 

 

 

 

2.2.2. PCR 増幅 

96 ウェルプレートを装置にセットし、反応とデータの取り込

みを開始する。反応条件は以下のとおりである。50ºC、2 分間

の条件で保持した後、95ºC で 10 分間加温し、ホットスタート

法で反応を開始する。その後、95ºC で 15 秒間、60ºC で 1分間

を 1サイクルとして、48サイクルの増幅反応を行う。最終増幅

反応終了後のcooling反応を適宜設定しても解析結果に影響は

ない。Remaining time が 0 分となっていることを確認し、反

応を終了させた後、測定結果の解析を行う。 

 

2.2.3. ABI PRISM 7900HT、ABI 7500 又は LightCycler 480 を

使用した操作方法 

以下参考として、ABI PRISM 7900HT、ABI 7500 又は

LightCycler 480 を使用した操作方法を記述するが、上記 3機

種と同等の性能を有するものも使用可とする。 

 

2.2.3.1. ABI PRISM 7900HT  

① オペレーション用 PC の電源を入れ、起動させる。PC が完

全に起動してから ABI PRISM 7900HT 本体の電源を入れ、30

分以上ウォーミングアップしたのちに反応を開始する。 

② デスクトップ上のアプリケーション [ABI PRISM 7900 SDS 

Software] をダブルクリックして開く。メニューバーの 

[File] → [New] を選択し、{New Document} ダイアログを



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表示させる。 {Assay} は  [Absolute Quantification 

(Standard Curve)]、{Container} は [96 Wells Clear 

Plate]、{Template} は [Blank Template] を選択し、[OK] 

ボタンをクリックする。 

③ メニューバーの [Tools] → [Detector Manager] を選択

し、{Detector Manager} ダイアログを表示させる。[New] ボ

タンをクリックし、{Add Detector} ダイアログを開く。

Detector の設定は、 MON71200 系統特異的検知試験では

Reporter を  HEX」又は VIC」、Quencher を  Non Fluorescent」、

コムギ陽性対照試験及び MON71700 系統特異的検知試験では

Reporter を  FAM」、Quencher を  TAMRA」、MON71100/71300 系

統特異的検知試験及び MON71800 系統特異的検知試験では

Reporter を FAM」、Quencher を Non Fluorescent」となる

ように設定し、[OK] ボタンをクリックする。{Detector 

Manager} ダイアログ上で使用する Detector（各試験）を選

択し、[Copy To Plate Document] ボタンをクリックし、[Set 

Up] タブ上に使用する Detector を登録し、最後に [Done] 

ボタンをクリックする。 

④ 画面左上枠で各ウェルを選択し、右枠の [Set Up] タブ上

で、Detector が [コムギ陽性対照試験]又は [各検知試験] 

の行の {Use} 欄にチェックを入れる。次にウェルごとに 

{Task} 欄でそれぞれの情報（Non-Template Control：NTC、

測定対象検体：Unknown）を選択し、{Sample Name} フィール



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.1.1. ABI 7500  

（ソフトウェアバージョンが Ver.1.5.1以前の場合） 

① オペレーション用 PC の電源を入れ、起動させる。PC が完

全に起動してから ABI 7500本体の電源を入れ、30分以上ウ

ドにサンプル番号を入力する。{Passive Reference} が 

[ROX] に設定されていることを確認する。 

⑤ [Instrument] タブ上の [Thermal Profile] よりサーマ 

ルサイクラー条件を以下のように設定する。[50℃, 2 分 → 

95℃, 10 分 → (95℃, 15 秒 → 60℃, 1 分) × 48 サイク

ル] 

⑥ {Sample Volume} を[25 L] に設定し、{9600 emulation 

モード} にチェックが入っていることを確認する。 

⑦ 設定条件をプレートドキュメント（.sds）として保存する。 

⑧ [Instrument] タブ上の [Connect] ボタンをクリックし、

PC と ABI PRISM 7900HT 本体を connect 状態にする。

[Instrument] タブ上の [Open / Close] ボタンをクリック

し、ステージを装置本体から出し、2.1.で調製した 96 ウェル

プレートの切欠き部を右上にしてステージ上に載せる。再び 

[Open / Close] ボタンをクリックし、96 ウェルプレートを

装置本体にセットする。 

⑨ [Instrument] タブ上の [Start] ボタンをクリックし、反

応とデータの取り込み（所要時間：約 2時間）を開始する。 

 

2.2.3.2. ABI 7500  

 

① オペレーション用 PC の電源を入れ、起動させる。PC が完

全に起動してから ABI 7500 本体の電源を入れ、30 分以上ウ



ォーミングアップしたのちに反応を開始する。 

②  デスクトップ上のアプリケーション  [7500 System 

Software] をダブルクリックして開く。メニューバーの 

[File] → [New] を選択し、{New Document} ダイアログを

表示させる。 {Assay} は  [Absolute Quantification 

(Standard Curve)]、{Container} は [96 Wells Clear]、

{Template} は [Blank Template] 、{Run Mode} を[9600 

emulation]とし、[NEXT] ボタンをクリックする。 

 

 

 

 

③ Detector の設定は、MON71200 系統特異的検知試験では

Reporterを HEX」又は VIC」、Quencherを Non Fluorescent」、

コムギ陽性対照試験及び MON71700 系統特異的検知試験では

Reporterを FAM」、Quencherを TAMRA」、MON71100/71300

系統特異的検知試験、MON71800系統特異的検知試験及び HB4

系統特異的検知試験では Reporter を FAM」、Quencher を

 Non Fluorescent」、とし、[ADD] ボタンをクリックする。

{Passive Reference} が [ROX] に設定されていることを確

認し、[NEXT] ボタンをクリックする。 

④ 画面下枠で各ウェルを選択し、上枠で、Detectorが [コム

ギ陽性対照試験] 又は [各検知試験] の行の {Use} 欄に

ォーミングアップしたのちに反応を開始する。 

②  デスクトップ上のアプリケーション [7500 System 

Software] をダブルクリックして開く。メニューバーの 

[File] → [New] を選択し、{New Document} ダイアログを

表示させる。 {Assay} は  [Absolute Quantification 

(Standard Curve)]、{Container} は [96 Wells Clear]、

{Template} は [Blank Template] 、Ver.1.5.1 以前のソフト

ウェアの場合は、{Run Mode} を[9600 emulation]とし、

[NEXT] ボタンをクリックする。Ver.2.0 以降のソフトウェア

の場合は ramp rate の変更が必要で温度が上昇していく部分

の ramp rate を 100%から 64%に変更する。なお、下降部分は

100%のままで使用する。 

③ Detector の設定は、MON71200 系統特異的検知試験では

Reporter を  HEX」又は VIC」、Quencher を  Non Fluorescent」、

コムギ陽性対照試験及び MON71700 系統特異的検知試験では

Reporter を FAM」、Quencher を TAMRA」、MON71100/71300 

系統特異的検知試験及び MON71800 系統特異的検知試験では

Reporter を FAM」、Quencher を Non Fluorescent」、とし、

[ADD] ボタンをクリックする。{Passive Reference} が 

[ROX] に設定されていることを確認し、[NEXT] ボタンをク

リックする。 

④ 画面下枠で各ウェルを選択し、上枠で、Detector が [コム

ギ陽性対照試験] 又は [各検知試験] の行の {Use} 欄に 



チェックを入れる。次にウェルごとに {Task} 欄でそれぞ

れの情報（Non-Template Control：NTC、測定対象検体：

Unknown）を選択し、[FINISH] ボタンをクリックする。 

⑤ [Setup] タブ上の各ウェルをダブルクリックし、サンプル

名を入力する。 

⑥ [Instrument] タブ上の [Thermal Cycle Protocol] より

サーマルサイクラー条件を以下のように設定する。[50℃, 2

分 → 95℃, 10分 → (95℃, 15秒 → 60℃, 1分) × 48

サイクル]。 

⑦ {Sample Volume} を[25 L] に設定する。 

⑧ 設定条件をプレートドキュメント（.sds）として保存する。 

⑨ 2.1. で調製した 96ウェルプレートの切欠き部を右上にし

て、装置本体のステージ上に載せセットする。 

⑩ [Instrument] タブ上の [Start] ボタンをクリックし、反

応とデータの取り込み（所要時間：約 2時間）を開始する。 

 

（ソフトウェアのバージョンが Ver.2.0以降の場合）  

① オペレーション用 PC の電源を入れ、起動させる。PC が

完全に起動してから ABI 7500 本体の電源を入れ、30 分

以上ウォーミングアップしたのちに反応を開始する。  

② デスクトップ上のアプリケーション  [7500 System 

Software] をダブルクリックして開く。トップ画面で 

[Advanced Setup] を選択し、新規プレートファイルを起

チェックを入れる。次にウェルごとに {Task} 欄でそれぞ 

れの情報（Non-Template Control：NTC、測定対象検体：

Unknown）を選択し、[FINISH] ボタンをクリックする。 

⑤ [Setup] タブ上の各ウェルをダブルクリックし、サンプル

名を入力する。 

⑥ [Instrument] タブ上の [Thermal Cycle Protocol] より

サーマルサイクラー条件を以下のように設定する。[50℃, 2

分 → 95℃, 10 分 → (95℃, 15 秒 → 60℃, 1 分) × 48

サイクル]。 

⑦ {Sample Volume} を[25 L] に設定する。 

⑧ 設定条件をプレートドキュメント（.sds）として保存する。 

⑨ 2.1. で調製した96ウェルプレートの切欠き部を右上にし

て、装置本体のステージ上に載せセットする。 

⑩ [Instrument] タブ上の [Start] ボタンをクリックし、反

応とデータの取り込み（所要時間：約 2時間）を開始する。 

 

（新設） 

 

 

 

 

 

 



動する。Experiment Properties 画面で {What type of 

experiment do you want to set up} を[Quantification 

Standard Curve]、{Which reagents do you want to use 

to detect the target sequence} を [TaqMan® Reagents]、

{Which ramp speed do you want to use in the instrument 

run} を [Standard] と設定する。 

③ Setup 画面内の {Define Targets and Samples} 画面の 

{Define Targets} 欄で、MON71200系統特異的検知試験で

は Reporterを HEX」又は VIC」、Quencherを None」、

コムギ陽性対照試験及び MON71700 系統特異的検知試験で

は Reporterを FAM」、Quencherを TAMRA」、MON71100/71300

系統特異的検知試験、MON71800 系統特異的検知試験、HB4

系統特異的検知試験は Reporter を [FAM]、Quencher を 

[None]となるよう設定する。また {Define Samples} 欄で

測定するサンプルの名称を入力する。  

④ {Assign Targets and Samples} 画面にて、ウェルごとに 

{Assign target(s) to the selected wells} 欄で target 

と task（Non-Template Control：NTC、測定対象検体：

Unknown）を、{Assign sample(s) to the selected wells} 

欄でサンプル名を指定する。また {Select the dye to use 

as the Passive Reference} は [ROX] と設定する。  

⑤ {Run method} 画面で、サーマルサイクラー条件を以下の

ように設定する。[50℃, 2分 → 95℃, 10分 → （95℃, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



15秒 → 60℃, 1分）× 48サイクル] なお ramp rate に

ついては、温度が上昇していく部分の ramp rateを 100%か

ら 64%に変更する。 なお、下降部分は 100%のままで使用す

る。 

⑥ {Reaction Volume Per Well} を [25 µL] に設定する。  

⑦ 設定条件をプレートドキュメント（.eds）として保存する。 

⑧ 1.1. で調製した 96ウェルプレートを装置本体のステージ

上に載せセットする。  

⑨ {Setup} 画面または {Run} 画面上の [Start Run] ボタン

をクリックし、反応とデータの取り込み（所要時間：約 2

時間）を開始する。 

 

2.2.1.2. LightCycler 480  

① LightCycler 480本体の電源を入れ、セルフテストが完了

して起動するまで約 5分待機する。オペレーション用 PCの

電源を入れ、起動させる。 

② デスクトップ上のアプリケーション [LightCycler480 SW] 

をダブルクリックし、[User Name]と[Password]を入力して

ソフトを立ち上げる。 

③ [New Experiment from Template] をクリックし{Create 

Experiment from Template}の一覧から、コムギ陽性対照試

験、MON71100/71300系統特異的検知試験、MON71700系統特

異的検知試験、MON71800 系統特異的検知試験及び HB4 系統

 

 

 

 

 

 

 

 

 

 

 

 

2.2.3.3. LightCycler® 480  

① LightCycler® 480 本体の電源を入れ、セルフテストが完了

して起動するまで約 5 分待機する。オペレーション用 PC の

電源を入れ、起動させる。 

② デスクトップ上のアプリケーション [LightCycler480 SW] 

をダブルクリックし、[User Name]と[Password]を入力して

ソフトを立ち上げる。 

③ [New Experiment from Template] をクリックし{Create 

Experiment from Template}の一覧から、コムギ陽性対照試

験、MON71100/71300 系統特異的検知試験、MON71700 系統特 

異的検知試験及び MON71800 系統特異的検知試験の場合は 



特異的検知試験の場合は [Mono color HydrolysisProbe-

UPL] を、MON71200 系統特異的検知試験の場合は [Dual 

color HydrolysisProbe-UPL] を選択し、OKする。 

④ [Run Protocol] タブで、{Reaction Volume} を[25] に設

定し、サーマルサイクラー条件を次のように設定する。

[50℃, 2分 → 95℃, 10分 → (95℃, 15秒 → 60℃, 1

分 [Single] ) × 48 サイクル→ 40℃,30秒] と設定する。 

⑤ Saveをクリックし設定条件を保存する。 

⑥ 本体のプレートローディングボタンを押してプレートロ

ーダーを出し、2.1. で調製した 96 ウェルプレートの切欠

き部を右下にしてセットした後、再度ボタンを押してプレ

ートローダーを格納する。 

⑦ [Start Run] をクリックし、反応とデータの取り込みを開

始する。 

⑧ （反応中に）[Subset Editor]にて、（+）ボタンから New 

Subset を作成し、サンプルをセットしたウェルを選択した

後 Applyをクリックする。 

⑨ [Sample Editor]にて、Step1: [Select Workflow]で Abs 

Quantを選択する。Step2: [Select Samples]内の[Subset]

のプルダウンメニューから、⑧で作成した Subsetを選択す

る。Step3: [Edit Abs Quant Properties]で、各ウェルを選

択し、[Sample Name]を入力し、{Sample Type} 欄でそれぞ

れの情報（Negative Control又は測定対象検体：Unknown）

[Mono color HydrolysisProbe-UPL] を、MON71200 系統特異

的検知試験の場合は [Dual color HydrolysisProbe-UPL] を

選択し、OK する。 

④ [Run Protocol] タブで、{Reaction Volume} を[25] に設

定し、サーマルサイクラー条件を次のように設定する。

[50℃, 2 分 → 95℃, 10 分 → (95℃, 15 秒 → 60℃, 1 

分 [Single] ) × 48 サイクル→ 40℃,30 秒] と設定する。 

⑤ Save をクリックし設定条件を保存する。 

⑥ 本体のプレートローディングボタンを押してプレートロ

ーダーを出し、2.1. で調製した 96 ウェルプレートの切欠 

き部を右下にしてセットした後、再度ボタンを押してプレ 

ートローダーを格納する。 

⑦ [Start Run] をクリックし、反応とデータの取り込みを開

始する。 

⑧ （反応中に）[Subset Editor]にて、（+）ボタンから New 

Subset を作成し、サンプルをセットしたウェルを選択した 

後 Apply をクリックする。 

⑨ [Sample Editor]にて、Step1: [Select Workflow]で Abs 

Quant を選択する。Step2: [Select Samples]内の[Subset] 

のプルダウンメニューから、⑧で作成した Subset を選択す

る。Step3: [Edit Abs Quant Properties]で、各ウェルを選

択し、[Sample Name]を入力し、{Sample Type} 欄でそれぞ

れの情報（Negative Control 又は測定対象検体：Unknown）



を選択する。 

 

2.2.1.3. QuantStudio 5  

① オペレーション用PCの電源を入れ、起動させる。PCが完全

に起動してからQuantStudio 5本体の電源を入れ、セルフ

テストが完了して本体が起動する事を確認する。 

② デスクトップ上のアプリケーション  [QuantStudio 

Design and Analysis Desktop Software v1.6.1] をダブ

ルクリックして開く。トップ画面の Create New 

Experiment」をクリックしてExperiment Properties画面

を表示する。{Experiment type} は [Standard Curve]、

{Chemistry} は [TaqMan Reagents] 、 {Run mode} は 

[Standard]を選択し、[NEXT] ボタンをクリックする。 

③ {Method} タブでサーマルサイクラー条件を以下のように

設定する。[50℃, 2分 → 95℃, 10分 → (95℃, 15秒 → 

60℃, 1分) × 48サイクル]と設定し、{Volume}を[25 µL] 

に設定する。[NEXT] ボタンをクリックする。 

④ {Plate}タブの{Advanced Setup}画面で{Targets}の設定

は、MON71200系統特異的検知試験ではReporterを [VIC]、

Quencherを[None]、コムギ陽性対照試験及びMON71700系統

特異的検知試験では Reporterを [FAM]、 Quencherを

[TAMRA]、MON71100/71300系統特異的検知試験、MON71800

系統特異的検知試験、HB4系統特異的検知試験はReporter

を選択する。 

 

（新設） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



を [FAM]、Quencherを [None]となるよう設定する。 

{Samples}で測定する未知サンプルの数だけAddボタンを

クリックしてサンプルの名前を入力する。 

⑤ 画面右枠で、ウェルごとに[target] と [task（Non-

Template Control：N、測定対象検体：U）]を選択する。 

⑥ 画面右枠でサンプルの入っているウェルを選択し、該当す

るsample名を画面左枠のSamplesから選択してチェックボ

ックスにチェックを入れる。 

⑦ {Quick setup} 画 面 Plate Attributes の {Passive 

Reference}が [ROX] に設定されていることを確認し、

[NEXT] ボタンをクリックする。 

⑧ 画面右上の[Save]ボタンをクリックして設定条件をプレ

ートドキュメント（.edt）として保存する。 

⑨ 2.1. で調製した96ウェルプレートを、装置本体のステー

ジ上に載せセットする。 

⑩ [Run]画面の [Start Run] ボタンをクリックし.edsファ

イルを保存してから、反応とデータの取り込み（所要時間：

約2時間）を開始する。 

 

2.2.1.4. QuantStudio 12K Flex 

① オペレーション用 PC の電源を入れ、起動させる。PC が完

全に起動してから QuantStudio 12K本体の電源を入れ、セ

ルフテストが完了して本体が起動する事を確認する。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（新設） 

 

 

 



② デスクトップ上のアプリケーション [QuantStudio 12K 

Flex Software] をダブルクリックして開く。トップ画面の

 Create」をクリックして Experiment Properties画面を

表示する。96-well(0.2mL)ブロックが選択されていること

を確認し、{What type of experiment do you want to 

setup?}は[Standard Curve]、{Which reagents do you want 

to use to detect the target sequence?}は [TaqMan 

Reagents]、 {What properties do you want for the 

instrument run?} は [Standard]を選択し、画面左の

[Define] をクリックする。 

③ Define画面で{Targets}の設定は、MON71200系統特異的検

知試験では Reporterを VIC」、Quencherを None」、コ

ムギ陽性対照試験及び MON71700 系統特異的検知試験は

Reporterを [FAM]、Quencherを [TAMRA]、MON71100/71300

系統特異的検知試験、MON71800 系統特異的検知試験及び

HB4系統特異的検知試験は Reporterを [FAM]、Quencherを 

[None]とする。{Samples}で測定する未知サンプルの数だけ

New ボタンをクリックしてサンプルの名前を入力する。

{Passive Reference} が [ROX] に設定されていることを

確認し、画面左の[Assign]をクリックする。 

④ 画面右枠でコムギ陽性対照試験と GM コムギ検知試験のウ

ェルを選択し、左枠の{Targets}で [コムギ陽性対照試験]

または [GM コムギ系統特異的検知試験]を選択しチェック

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



を入れる。次にウェルごとに[Task]欄でそれぞれの情報

（No-Template Control：NTC [N]、測定対象検体：Unknown 

[U]）を選択する。 

⑤ 画面右枠でサンプルの入っているウェルを選択し、該当す

る sample名を画面左枠の Samplesから選択してチェックボ

ックスにチェックを入れ画面左の[Run Method]をクリック

する。 

⑥ サーマルサイクラー条件を以下のように設定する。 

[50℃, 2分 → 95℃, 10分 → (95℃, 15秒 → 60℃, 1

分) × 48サイクル] 

⑦ {Reaction Volume per well} を[25 µL] に設定する。 

⑧ 設定条件をプレートドキュメント（.eds）として保存する。 

⑨ 2.1.で調製した 96 ウェルプレートを装置本体のステージ

上に載せセットする。 

⑩ [Run]画面の [Start Run] ボタンをクリックし、反応とデ

ータの取り込み（所要時間：約 2時間）を開始する。 

 

2.2.1.5. その他の同等性能を有する機種での測定の留意点 

2.2.1.5.1. プレート情報の設定 

検体の配置とプローブの特性に注意しながら、リアルタイム

PCR機器の製品付属のマニュアルを参考にして設定する。プロ

ーブ特性に関しては、 MON71200系統特異的検知試験では

Reporterを HEX」又は VIC」、Quencherを Non Fluorescent」、

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（新設） 

 

 

 

 

 



コムギ陽性対照試験及びMON71700系統特異的検知試験では

Reporterを FAM」、Quencherを TAMRA」、MON71100/71300系

統特異的検知試験、MON71800系統特異的検知試験及びHB4系統

特異的検知試験ではReporterを FAM」、Quencherを Non 

Fluorescent」となるように設定する。また、Passive Reference

の指定のあるリアルタイムPCR機器の場合は、 ROX」を設定す

る。Sample Volumeは25 µLに設定する。 

 

2.2.1.5.2. PCR増幅 

96ウェルプレートを装置にセットし、反応とデータの取り込

みを開始する。反応条件は以下のとおりである。50ºC、2分間の

条件で保持した後、95ºCで10分間加温し、ホットスタート法で

反応を開始する。その後、95ºCで15秒間、60ºCで1分間を1サイ

クルとして、48サイクルの増幅反応を行う。最終増幅反応終了

後のcooling反応を適宜設定しても解析結果に影響はない。

Remaining time が0分となっていることを確認し、反応を終了

させた後、測定結果の解析を行う。   

 

3. 結果の解析と判定 

リアルタイムPCR反応の結果の判定は増幅曲線上で、蛍光色

素由来の蛍光強度（FAM又はHEX）の指数関数的な明確な増加及

びCq値の確認をもって行う。各系統特異的な検知試験におい 

て目視で指数関数的な増幅曲線が確認された場合には、遺伝子

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. 結果の解析と判定 

リアルタイム PCR 反応の結果の判定は増幅曲線上で、蛍光色

素由来の蛍光強度（FAM 又は HEX）の指数関数的な明確な増加及

び Cq 値の確認をもって行う。各系統特異的な検知試験におい

て目視で指数関数的な増幅曲線が確認された場合には、遺伝子



組換えコムギの陽性を疑う。 

 

ABI 7500を使用した場合のデータの解析 

 

① メニューバーの [Analysis] → [Analyze] を選択する。 

②  画 面 右 枠 の  [Result] タ ブ を ク リ ッ ク し て 

{Amplification Plot} 画面を表示させる。 

③ {Amplification Plot} 画面上の {Plot} 欄で [ΔRn vs 

Cycle] を表示させ、ベースラインを 3サイクルから 15サ

イクルで設定し、{Threshold} 欄に [0.2] と入力する。 

④ {Amplification Plot} 画面上の {Detector} 欄で [All] 

を選択する。表中に Ct (Cq) 値が表示される。 

 

（ソフトウェアのバージョンがVer.2.0以降の場合）  

① {Analysis} 画面を開き、画面上部の {Analysis Setting} 

をクリックする。  

② {Ct Setting} タグをクリック。ベースラインを3サイクル

から15サイクルで設定し、{Threshold} 欄に [0.2] と入

力する。 

③ {Applying Analysis Settings} をクリック。  

④ {Amplification Plot} 画面で、表中に Ct （Cq）値が表示

される。 

 

組換えコムギの陽性を疑う。 

 

ABI PRISM 7900HT 又は ABI 7500 を使用した場合のデータの解    

析 

① メニューバーの [Analysis] → [Analyze] を選択する。 

②  画 面 右 枠 の  [Result] タ ブ を ク リ ッ ク し て 

{Amplification Plot} 画面を表示させる。 

③ {Amplification Plot} 画面上の {Plot} 欄で [ΔRn vs 

Cycle] を表示させ、ベースラインを 3 サイクルから 15 サ 

イクルで設定し、{Threshold} 欄に [0.2] と入力する。 

④ {Amplification Plot} 画面上の {Detector} 欄で [All] 

を選択する。表中に Ct(Cq) 値が表示される。 

 

（新設） 

 

 

 

 

 

 

 

 

 



LightCycler 480を使用した場合のデータの解析 

① [Analysis]ボタンをクリックし{Create new analysis}に

て、[Abs Quant/2nd Derivative Max] を選択し [Subset] 

プルダウンから作成した Subsetを選択し [OK]をクリック

する。 

② 表示された画面で、[Calculate]をクリックする。 

③ 増幅曲線と、[Result Table] に Cp (Cq)値が表示される。 

 

QuantStudio 5を使用した場合のデータ解析 

（ソフトウェアがQuantStudio Design and Analysis Desktop 

Software v1.6.1の場合） 

① { Results }タブを選択する。 

②  画面内のプルダウンから[Amplification Plot]を選択し

{Amplification Plot}画面を表示させる。 

③ 画面右上のAnalyzeボタン右にあるSettingボタン（歯車）

をクリックしてAnalysis setting画面を表示させる。各試

験について、Ct Settings to Use：Default Settingsのチ

ェックボックスを外し、次にAutomatic Thresholdのチェッ

クを外して {Threshold} 欄に  [0.2] と入力する。

Automatic Baseline のチェックを外し、Baselineを3サイ

クルから15サイクルで設定する。この操作を実施したすべ

ての試験について行って設定変更後に画面右下の[Apply]

ボタンをクリックする。 

LightCycler 480 を使用した場合のデータの解析 

① [Analysis]ボタンをクリックし{Create new analysis}に

て、[Abs Quant/2nd Derivative Max] を選択し [Subset]  

プルダウンから作成したSubsetを選択し [OK]をクリック 

する。 

② 表示された画面で、[Calculate]をクリックする。 

③ 増幅曲線と、[Result Table] に Cp (Cq)値が表示される。 

 

（新設） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



QuantStudio 12K Flexを使用した場合のデータ解析 

（ソフトウェアが QuantStudio 12K Flex Real-time PCR 

instrument Software v1.8の場合） 

① {Analysis}タブを選択する。 

②  [Amplification Plot]を選択し{Amplification Plot}画

面を表示させる。 

③ 画面右上のAnalyzeボタン右にあるAnalysis Settingボタ

ンをクリックしてAnalysis setting画面を表示させる。各

試験について、Ct Settings to Use：Default Settingsの

チェックボックスを外し、次にAutomatic Thresholdのチェ

ックを外して{Threshold} 欄に [0.2] と入力する。

Automatic Baseline のチェックを外し、Baselineを3サイ

クルから15サイクルで設定するこの操作を実施したすべて

の試験について行って設定変更後に画面右下の[Apply]ボ

タンをクリックする。 

 

2併行抽出したそれぞれのDNA試料液について、以下の結果 

の判定スキーム（図１参照）に従って判定する。 

各DNA試料液において、 

(1) コムギ陽性対照試験にて2ウェル併行全てで43未満のCq 

値が得られ、かついずれかの系統特異的検知試験にて2ウ 

ェル併行全てで43未満のCq値が得られた場合、当該試料 

は 陽性」と判定する。 

（新設） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2 併行抽出したそれぞれの DNA 試料液について、以下の結果

の判定スキーム（図１参照）に従って判定する。 

各 DNA 試料液において、 

(1) コムギ陽性対照試験にて 2ウェル併行全てで 43 未満の Cq

値が得られ、かついずれかの系統特異的検知試験にて 2ウ

ェル併行全てで 43 未満の Cq 値が得られた場合、当該試料

は 陽性」*と判定する。 



(2) コムギ陽性対照試験にて2ウェル併行全てで43未満のCq 

値が得られ、かついずれかの系統特異的検知試験にて2ウ 

ェル併行全てで43未満のCq値が得られなかった場合、当 

該試料は 陰性」と判定する。 

(3) コムギ陽性対照試験にて2ウェル併行全てで43未満のCq 

値が得られ、かついずれかの系統特異的検知試験にて2ウ 

ェル併行全てで一致した結果が得られなかった場合は、再

度、検体からの 1. DNA抽出精製」以降の操作を行い、判

定する。再抽出精製したDNA試料液の試験においても 陽 

性」の判定が得られない場合には、 陰性」と判定する。 

また、コムギ陽性対照試験にて少なくとも1ウェルで43未 

満のCq値が得られないDNA試料液については、再度、検体か  

らの 1. DNA抽出精製」以降の操作を行い、それでもコムギ陽

性対照試験にて少なくとも1ウェルで43未満のCq値が得られ 

ない場合には、本試料からは遺伝子組換えコムギは 検知不能」

とする。 

次に、上記の判定結果を基に、遺伝子組換えコムギの混入の

有無を判断する。2 併行抽出した両方の DNA 試料液において、

 陽性」と判定された検体は、 遺伝子組換えコムギ混入」と

判断する（表 1参照）。少なくとも一方の DNA試料液の試験に

おいて 陰性」と判定された検体は、 遺伝子組換えコムギ混

入なし」と判断する。 

 

(2) コムギ陽性対照試験にて 2ウェル併行全てで 43 未満の Cq

値が得られ、かついずれかの系統特異的検知試験にて 2ウ

ェル併行全てで 43 未満の Cq 値が得られなかった場合、当

該試料は 陰性」と判定する。 

(3) コムギ陽性対照試験にて 2ウェル併行全てで 43 未満の Cq

値が得られ、かついずれかの系統特異的検知試験にて 2ウ

ェル併行全てで一致した結果が得られなかった場合は、再

度、検体からの 1. DNA 抽出精製」以降の操作を行い、判

定する。再抽出精製した DNA 試料液の試験においても 陽

性」の判定が得られない場合には、 陰性」と判定する。 

また、コムギ陽性対照試験にて少なくとも 1 ウェルで 43 未

満の Cq 値が得られない DNA 試料液については、再度、検体か

らの 1. DNA 抽出精製」以降の操作を行い、それでもコムギ陽

性対照試験にて少なくとも 1ウェルで 43未満の Cq値が得られ

ない場合には、本試料からは遺伝子組換えコムギは 検知不能」

とする。 

次に、上記の判定結果を基に、遺伝子組換えコムギの混入の

有無を判断する。2 併行抽出した両方の DNA 試料液において、

 陽性」と判定された検体は、 遺伝子組換えコムギ混入」と 

判断する（表 1 参照）。少なくとも一方の DNA 試料液の試験に

おいて 陰性」と判定された検体は、 遺伝子組換えコムギ混 

入なし」と判断する。 

 



表１.   遺伝子組換えコムギが混入している」と判定される試

験結果 

図１ 結果の判定スキーム 

表１.  遺伝子組換えコムギが混入している」と判定される試

験結果 



コメ（63Bt、NNBt、CpTI）の検査方法 

（略） 

1. DNA 抽出精製 

（略） 

2. 定性リアルタイム PCR 法（ABI PRISMTM 7900 または 7500） 

（略） 

3. 結果の解析と判定（図 1参照） 

（略） 

（参考） 

（１）イオン交換樹脂タイプの DNA 抽出精製キット（QIAGEN 

Genomic-tip）は、QIAGEN 社から購入可能である。シリ

カゲル膜タイプキット法（NIPPON GENE GM quicker 2 変

法）の NIPPON GENE GM quicker 2 キットは、ニッポン

ジーン社から購入可能である。 

 

 

 

（２）コメの検査法に用いるプライマー対、プローブ（CpTI コ

メ検出用プローブ（KDEL-P）を除く。）およびリアルタイ

ム PCR 法用標準プラスミド （GM コメ害虫抵抗性コメ検査

用陽性コントロールプラスミド）は、ニッポンジーン社

又はファスマック社から購入可能である。 

 

コメ（63Bt、NNBt、CpTI）の検査方法 

（略） 

1. DNA 抽出精製 

（略） 

2. 定性リアルタイム PCR 法（ABI PRISMTM 7900 または 7500） 

（略） 

3. 結果の解析と判定（図 1参照） 

（略） 

（参考） 

（１）イオン交換樹脂タイプの DNA 抽出精製キット（QIAGEN 

Genomic-tip）は、QIAGEN 社 （ 104-0054 東京都中央区勝

どき 3-13-1 FOREFRONT TOWER II. Tel. 03-6890-7300 

Fax. 03-5547-0818）から購入可能である。シリカゲル膜

タイプキット法（NIPPON GENE GM quicker 2 変法）の

NIPPON GENE GM quicker 2 キットは、ニッポンジーン社

（ 930-0834 富山市問屋町 1-8-7. Tel.076-451-6548 

Fax. 076-451-6547）から購入可能である。 

（２）コメの検査法に用いるプライマー対、プローブ（CpTI コ

メ検出用プローブ（KDEL-P）を除く。）およびリアルタイ

ム PCR 法用標準プラスミド（GM コメ害虫抵抗性コメ検査

用陽性コントロールプラスミド）は、ニッポンジーン社

（ 930-0834 富山市問屋町 1-8-7. Tel. 076-451-6548 

Fax. 076-451-6547）又はファスマック社 （ 243-0041 厚



 

 

（３）コメの検査法に用いるプローブのうち、CpTI コメ検出用

プローブ（KDEL-P）についてはThermo Fisher Scientific

社から購入可能である。 

 

（略） 

 

コメ（LL601）の検査方法 

（略） 

  

トウモロコシ（Bt10）の検査方法 

（略） 

  

トウモロコシ（CBH351）の検査方法 

（略） 

  

トウモロコシ（DAS59132）の検査方法 

（略） 

  

ナタネ（RT73 B. rapa）の検査方法 

（略） 

  

木市緑ヶ丘 5-1-3. Tel. 046-295-8787 Fax. 046-294-

3738）から購入可能である。 

（３）コメの検査法に用いるプローブのうち、CpTI コメ検出用

プローブ（KDEL-P）については Thermo Fisher Scientific

社 （ 108-0023 港区芝浦 4-2-8 住友不動産三田ツインビ

ル東館 Tel. 03-6832-9300）から購入可能である。 

（略） 

 

コメ（LL601）の検査方法 

（略） 

  

トウモロコシ（Bt10）の検査方法 

（略） 

  

トウモロコシ（CBH351）の検査方法 

（略） 

  

トウモロコシ（DAS59132）の検査方法 

（略） 

  

ナタネ（RT73 B. rapa）の検査方法 

（略） 

  



パパイヤ（PRSV-YK、PRSV-SC、PRSV-HN）の検査方法 

（略） 

  

ばれいしょ（F10、J3）の検査方法 

（略） 

 

サケ（AquAdvantage）の検査方法 

（略） 

 

ズッキーニ（ZW20、CZW3）の検査方法 

（略） 

 

Ⅲ．検査方法の同等性確認方法 

1. DNA 抽出精製方法について 

（略） 

2. リアルタイム PCR 装置について 

 Ⅱ．個別検査方法」で主に用いられている ABI7500 又は

LightCycler96 等の他にも同等の性能を有する機種を用いる事

ができる。同等の性能の確認は、感度、繰り返し再現性、ウェ

ル間差及び増幅効率（特に定量する場合）などを考慮して行う。

例えば、市販陽性対照プラスミド（例えば、コメ用）を用意し、

現行機種（ABI 7500 等）を用いて検出限界より少し高い濃度（10

回中 10 回すべて検出される最低濃度）の希釈溶液を作製する。

パパイヤ（PRSV-YK、PRSV-SC、PRSV-HN）の検査方法 

（略） 

  

ばれいしょ（F10、J3）の検査方法 

（略） 

 

サケ（AquAdvantage）の検査方法 

（略） 

 

ズッキーニ（ZW20、CZW3）の検査方法 

（略） 

 

Ⅲ．検査方法の同等性確認方法 

1. DNA 抽出精製方法について 

（略） 

2. リアルタイム PCR 装置について 

 Ⅱ．個別検査方法」で主に用いられている ABI PRISM 7900

又は LightCycler96/480の他にも同等の性能を有する機種を用

いる事ができる。同等の性能の確認は、感度、繰り返し再現性、

ウェル間差及び増幅効率（特に定量する場合）などを考慮して

行う。例えば、市販陽性対照プラスミド（例えば、コメ用）を

用意し、現行機種（ABI PRISM 7900 等）を用いて検出限界より

少し高い濃度（10 回中 10 回すべて検出される最低濃度）の希



その溶液を用いて、確認したい機種で同様の試験を行い、また、

日を変えて 3回以上行った結果、すべて検出されること。96ウ

ェル間で差がないことを確認する（Cq 値に最大でも 1 以上の

差がない。）。 

3. マスターミックスについて 

(略) 

釈溶液を作製する。その溶液を用いて、確認したい機種で同様

の試験を行い、また、日を変えて 3回以上行った結果、すべて

検出されること。96 ウェル間で差がないことを確認する（Cq 値

に最大でも 1以上の差がない。）。 

3. マスターミックスについて 

(略) 


